
ActivMan Quick	Start	Guide
Version	3.3

With v3.1 a new quick start wizard was introduced to allow users to get Ac�vMan up-and-running 

quickly. It contains step-by-step procedures for comple�ng the quick start wizard and for performing

the most common tasks when first star�ng out using the applica�on.

 

Launching ActivMan (main application)

On launching Ac�vMan for the first �me you will be presented with a welcome wizard which will 

guide you through configuring the applica�on for the first �me. 

Click 'Next' to start the wizard or click 'Cancel' to close it. Closing the wizard will load the main 

applica�on without configuring it. 

If you do cancel the welcome wizard and need to get back in to it again then you must launch the 

applica�on with "/showwelcomewizard" as an argument: 

Ac�vMan.exe /showwelcomewizard 
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On the license page of the wizard enter your license details. These must be entered exactly as given 

to you otherwise the key will be invalid. Also, you will receive an invalid license key error message if 

the expira�on date of the key has passed. 
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On the Ac�ve Directory server page of the wizard you must enter the connec�on details to access 

your Ac�ve Directory network. This can be any domain controller that matches the domain you are 

trying to connect to. 

The 'Server' can be either an IP address or server name. 

The 'AD Root' MUST be entered in the format of "dc=mydomain,dc=local", if your name is 

"mydomain.local". 

Next you MUST enter a username and password to access the AD network. It is advisable to use a 

domain administrator and to enter the username in the format of "administrator@mydomain.local".

If your AD network u�lises a special connec�on type then select the appropriate type from the 

'Type' op�ons. 

You can choose whether to automa�cally connect to this AD server when Ac�vMan starts by 

selec�ng 'Yes' for 'Connect on startup'. 

If this domain is split over mul�ple sites where user accounts are stored in different OU's and user's 

home directories are stored on different servers, i.e. servers located at each site, then select 'Single 

domain across mul�ple sites' from the 'Installa�on Type' op�ons. On the next page of the wizard you

will be able to specify the OU's and home directory loca�ons for each site. 
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On clicking 'Next' the wizard will a?empt to connect to the specified AD domain controller. If it fails 

then you will be directed back to this page of the wizard to verify and correct the connec�on details. 

On the Site Op�ons page of the wizard you will need to specify all of the OU's and home directory 

paths for each site. This will need replica�ng across all Ac�vMan installa�ons across all sites, leaving 

off "this site" each �me. 

The 'Home Directory Path' for each site needs to be accessible by each site as Ac�vMan will a?empt 

to move a user's home directory from another site to "this site" if their user account is being moved, 

which is op�onal. 
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On the MIS Types page of the wizard you can specify which MIS's you would like to use with 

Ac�vMan. Simply click 'Auto Detect' for Ac�vMan to search the Ac�vMan installa�on folder for any 

compa�ble MIS's installed. If you need to you can manually add another MIS by clicking on the 

empty row and entering a name and browsing to the DLL. 
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On the MIS page of the wizard you must enter the connec�on details for your MIS. Your MIS must be

accessible from the system you are running Ac�vMan on. 

The 'Server' can be either an IP address or server name, along with the instance, e.g. "MISSERVER\

MIS". 

Select the MIS type from the 'Type' op�ons. These will be the MIS's you have configured on the MIS 

Types page of the wizard. 

Next, enter the creden�als for your MIS DATABASE. This is NOT the creden�als that you use to login 

to your MIS but the creden�als to access the database directly. 

Once you have entered the creden�als you can click 'Find' where Ac�vMan will login to the specified 

database and a?empt to find your MIS database. If this fails to detect your MIS then you can 

manually enter the database. 

On clicking 'Next' the wizard will a?empt to connect to the specified database. If it fails then you will 

be directed back to this page of the wizard to verify and correct the connec�on details. 
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On the Ac�vMan Op�ons page of the wizard you can configure some required op�ons. In most cases

the default op�ons should be sufficient but can be changed here if required. You can change these at

a later �me by accessing them in Op�ons. 

The 'User ID Field Name' is the AD user account a?ribute used to store an MIS ID in each user 

account. This is required to link each person in your MIS to an associated AD user account. By 

default, Ac�vMan uses "employeeID". 

In some educa�on establishments students do not always have a UPN (Unique Pupil Number), which

is the "ID" used to store in each student AD account. Therefore you can change the "ID" from being 

the UPN to something else that suits your educa�on establishment. 

The 'Match Old Accounts By' op�on is used when a?emp�ng to match exis�ng user accounts to 

people you are trying to import (either from your MIS or a CSV file). So, when someone is extracted 

from your MIS a search is performed based on this op�on. However, a secondary check is performed

to match the ID to ensure it is the correct account. 

The 'Empty Start Date Ac�on' op�on is used to inform Ac�vMan what to do when we encounter 

someone who has no start date specified. 

Once you are happy with all of these seIngs then click 'Next'. 
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On the Import Op�ons page of the wizard you can specify what to do when certain events are 

encountered during import. 

The 'Delete le3 users' op�on will delete any user accounts encountered where the person has been 

determined to have "le3", i.e. their date of leaving is before "today" (or the import date). 

The 'Disable le3 users' op�on will disable any user accounts encountered where the person has been

determined to have "le3", i.e. their date of leaving is before "today" (or the import date). If 'Delete 

le3 users' is selected then this will be ignored as the account will be deleted. 

The 'Move le3 users' op�on will move any user accounts encountered where the person has been 

determined to have "le3", i.e. their date of leaving is before "today" (or the import date). If 'Delete 

le3 ' is selected then this will be ignored as the account will be deleted. With this op�on enabled you

MUST specify an OU to move the accounts to. 

The 'Unique suffice number length' op�on is used to specify the length of the unique number added 

to the end of user accounts when account names already exist. For example, if this op�on is set to 

"1" then only a single digit will be appended to the account, whereas a value of "2" would create 2 

digits (e.g. "01"). 

Once you are happy with all of these seIngs then click 'Next'. 
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On the Custom Year Groups page of the wizard you can specify any "custom years" already 

configured in your MIS. For example, some primary schools have a nursery year which is some�mes 

labelled as "N1". 

NOTE: Only enter one custom year per line, with no spaces or tabs or non-alphanumeric characters, 

unless they are present in the custom year being entered. 

Once you entered all of the custom year groups you think you will need then click 'Next'. 
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On the Complete page of the wizard simply click 'Finish' to save all of your change, close the wizard, 

and launch the main applica�on. 

Creating a template

To ease the administra�on of different types of user, i.e. Year 7 students, office staff, teacher, etc, 

you ideally need to create a template for each different type of people. These templates will be used

to import users from your MIS or create new users manually. 

To do this, follow these steps: 

a. Ensure you are connected to a server. 

b. Either: 

i. Select 'Templates' from the list on the le3 and right click in the Templates list, and 

click 'New Template'. 

ii. Right click 'Templates' from the list on the le3 and select 'New Template'. 

iii. Select 'Template' from the 'New' menu in the 'File' menu. 

iv. Click 'New Template' from the toolbar. 
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c. On the 'General' tab, Enter a name and descrip�on to indicate to you who this template is 

for. 
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d. Select the 'User Details' tab. 

 

e. Select a display name format from the drop down list or enter a custom format. 

f. Select a username format from the drop down list. If a format does not match your 

requirements then you select 'Custom' to specify a custom format. 

g. If you have select 'Custom' for username format, enter a prefix and suffix, and select a 

format. You can select 'Custom' again where you will have to complete the 'Further 

Customisa�on' sec�on. 

h. Select a conflict resolu�on if the username already exists. NOTE: If you are using this 

template for auto impor�ng then it is highly advisable to select 'Ignore', as duplicate user 

accounts will be created for people who have not been created by this applica�on 

previously. 

i. Complete all other desired fields of the 'User Details' tab. 

j. Select the 'Member Of' tab and add any desired groups for this type of user. 

k. Select the 'Password' tab. 

l. Specify what the new users' password is going to be. 'Date of Birth' is used when impor�ng 

users and crea�ng manually. The last op�on allows you to enter a predefined password that 
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will be common with all users who are created from this template. 

m. Select any desired password op�ons. 

n. Select 'Home Directory' tab. 

o. If you would like a home directory crea�ng for the user then select 'Create Home Directory'. 

p. If selected, enter the server and the root path for the home directory. NOTE: the root path 

MUST be how the server sees it, i.e. "C:\Users" and not "\\server\users" or "C$\Users". 

q. You can specify whether to add the created user to the permissions of the created home 

directory. Any inheritable permissions will be propagated. 

r. You can also specify any addi�onal permissions by clicking 'Permissions'. 

s. If you would like a share crea�ng for the created home directory for the user then select 

'Create Share from Home Directory'. 

t. If selected, select the format of the share. 

u. Enter a share descrip�on. 

v. Select how many users can access the share for 'Max Users'. 

w. You can specify whether to add the created user to the permissions of the created share. 

x. You can also specify any addi�onal permissions by clicking 'Permissions'. 

y. If you would like the created home directory to be added to the user account then select 

'Add directory to user account' and select and specify a drive le?er (op�onal). 

z. Click 'OK' and enter a filename for this template. 

Importing users from your MIS using the Extract Wizard

Firstly, ensure you have already created a connec�on to your MIS system and have at least one 

template before proceeding. 

To extract users from your MIS to either your Ac�ve Directory network or a file, simply: 

Select the 'File' menu, then 'Extract...' 
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Click 'Next'. 
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To extract users from your MIS to a file select 'File'. Enter a filename to save the extracted users to. If

you wish to have the file encrypted then select 'Encrypt'. 

-- OR -- 

To extract users from your MIS to Ac�ve Directory select 'Ac�ve Directory'. Select the OU to extract 

the users to. Select 'Test' if you would like to simulate extrac�ng and impor�ng the user accounts. 

Click 'Next'. 
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Select whether you would like to create user accounts, groups, or both from the 'Create' drop down 

list. 

Specify the "virtual date" to determine which users have started, le3, and moved groups. 

If you would like to select which users to extract, then select 'Customise Selec�on'. 

If you would like to extract sets then select 'Extract and sync teaching sets'. 

If you require UDFs to be extracted, then select 'Extract UDFs'. 

If you have enabled 'Create Year Groups' in the main op�ons then you can enable for this import 

whether to create and manage year groups. To configure this op�on please look at the main op�ons 

If you would like to create and manage "teachers of student" groups then �ck the 'Create and 

manage teachers of student groups'. This will create a distribu�on group for each student which 

contain all the staff that teach that student. 

If you would like to move exis�ng accounts to the specified OU then check the op�on 'Move exis�ng 

accounts to this OU' 

If you have a single domain across mul�ple sites then you can select whether to move user accounts 

from another site's OU to "this" site's OU. 
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If you have selected moving accounts to "this" sites OU then you can select whether to move user's 

data too from the other site's server. 

Click 'Next'. 

Select which year you would like to extract, e.g. 'Year 7', and click 'Next' 
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Select the database you would like to extract users from and click 'Next'. 
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If you selected 'Admissions' for the year then the admission groups will be extracted from the 

selected MIS, and you will need to select which admissions group to extract. Then click 'Next'. 
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If you selected to import teaching groups then you will be requested for the OU where exis�ng 

teaching groups reside and where new teaching groups will be created. Navigate and select the 

desired OU. If you have teaching groups in another loca�on then �ck 'Search for teaching sets'. 

Click 'Next'. 
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Select the template you would like to use for the extracted users. Then click 'Next'. 
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If you have selected 'Customise Selec�on' then, from the list, select which users to extract and click 

'Next'. 
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Now select any ac�ons you would like to be performed when certain events occur. When finished 

click 'Finish' 

All the extracted users will be either imported into Ac�ve Directory or exported to a file using the 

op�ons you have selected. 

Importing users from your MIS using AutoImport

Ac�vMan AutoImport is a program which can be scheduled to automa�cally extract specified users 

from your MIS and import into your Ac�ve Directory. This would then remove the need to manually 

perform the opera�on every �me a new user arrives or an old user leaves. 

To do this, follow these steps: 

a. Either: 

i. From Ac�vMan, select 'Configure AutoImport' from the 'Tools' menu. 

ii. From the Start Menu, select 'Configure' from the AutoImport submenu of the 

Ac�vMan menu group. 

b. On the 'MIS' tab, select your MIS server. These MIS servers are taken from the main 

applica�on, so you will need to configure your server in the main applica�on first.
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c. Select the 'Extract' tab.

 

d. Select the years and/or staff that you wish to extract from your MIS. If your MIS supports 

'Admissions' then you can specify this too by selec�ng "[Admissions]" and clicking 'Select 

Admissions'. 

e. If you would like to see what will be imported without actually modifying your Ac�ve 

Directory, then select 'Test only'. 

f. Select the 'SeIngs' tab. 

g. You now need to enter each year that you wish to create accounts for, i.e. Year 7, Year 8, 

etc. 

i. Click 'Add' 
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ii. Select the year to be imported. 

iii. Select a template to be associated with this year. This template must be created 

from the main Ac�vMan applica�on. NOTE: Each year can use the same template if 

necessary. 

iv. Select the Ac�ve Directory server from the list that this account will be created on. 

v. Browse for a desired OU on the specified server where these accounts will be 

created. 

vi. Click 'OK' to save the year. 

h. Repeat this process for all the years you are going to import. 

i. Select the 'Teaching Sets' tab. 

j. If you would like to search your teaching sets in your MIS and create associated groups then 

select 'Yes' for 'Search for Teaching Sets'. 

k. If you have selected 'Yes' to the above the then you will need to specify a loca�on to create 

the teaching groups. 

l. Select from the drop down box what type the teaching groups will be when created. 

m. Select the 'Op�ons' tab and specify any desired seIngs. 

n. For 'single domains across mul�ple sites' you are advised to select 'Yes' for 'Remove user 

from member groups'. Also check 'Move accounts to this site' and 'Move data to this site' if 

desired. 

o. Select the 'Ac�ons' tab and select any ac�ons to be performed when any desired events 

occur. 

p. Click 'Apply' to save the seIngs. 

q. On successfully connec�ng to the server you are now ready to go. You can either 'Run Now' 

or schedule this program to run at a future �me. 

NOTE

When moving data between sites the applica�on may take a long �me to complete, depending on 

the size of the data to move. Therefore, if you "Run Now" you may not be able to close the 

applica�on un�l the data has been moved. This will also occur when running the applica�on as a 

scheduled task. 

Scheduling AutoImport

To schedule the AutoImport applica�on to run at any �me you wish, create a standard Windows 

scheduled task (this will vary depending on the opera�ng system): 

a. Open Windows Scheduler 

b. Create a new task 

c. Select the Ac�vMan AutoImport executable 

d. Ac�vMan AutoImport does not requrie any addi�onal arguments 

e. Select the desired date/day/�me for the schedule to run 

f. Click 'OK' to create the schedule. It will now run at the specified date/�me. 
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